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About this tutorial…  

Thank you for choosing uDirect Studio — a variable data printing (VDP) solution 
from XMPie®, a Xerox company. uDirect Studio is an integrated suite of XMPie 
software — uCreate Print plug-in, uImage® and uChart™ — that creates variable 
data printing documents with more impact and relevance through advanced 
variable data personalization tools. 
With uDirect Studio, designers use the uCreate Print plug-in for Adobe InDesign® 
to create impressive variable data-driven documents with personalized images and 
illustrations created with XMPie uImage and attention-grabbing personalized 
charts created with uChart. 
This tutorial will help you get started with uDirect Studio by showing you how to 
use the uCreate Print plug-in to create a VDP Campaign that includes uImage and 
uChart elements, from concept to production. 
For the purposes of this tutorial, your client is a fictitious university named EDU.  
EDU wants you to create a new campaign called uDirect Studio Tutorial, inviting 
university prospective students to come to an open house event and learn more 
about the university.  
It is recommended to allocate three hours to complete this tutorial.  

Audience  
This tutorial is intended for Adobe InDesign users who want to create variable-data 
documents. If you are new to using InDesign, you may need to refer to Adobe’s 
help and documentation on InDesign while working through this tutorial. 
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Tutorial Organization  
The creation of the uDirect Studio Tutorial campaign comprises a series of tasks. 
The tasks in the tutorial change the campaign, step by step, from a static postcard 
into a variable data postcard, personalized for each Recipient.  
It is recommended to perform the tasks in the order in which they are presented. 
To start the tutorial, go to page 9. 
This tutorial includes the same information as the uDirect Classic Tutorial, with the 
addition of explanations about uDirect Studio-specific features. If you have already 
completed the uDirect Classic tutorial, you can go directly to the uImage (section  G) 
and uChart (section  H) sections, which cover the gap between these tutorials. 
To learn more about the campaign described in this tutorial and the materials 
included with it, read: 

• The Quick Reference to Campaign Content Objects section below. It describes 
the different content objects used in this Campaign. 

• Appendix B: uDirect Studio Tutorial Materials Specifications, on page 69. 
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Quick Reference to Campaign Content Objects 

Figure 1: uDirect Studio Tutorial Postcard front and back 

Page 1- Front of postcard  

 
 
 
Page 2- Back of postcard  

 
The next section includes a list of the content objects used in the uDirect Studio 
Tutorial postcard, grouped by the object type (text, image, etc.). Each object is 
followed by its task number in the tutorial. 
A Quick Task List is available on page 66 . 

Color varies by 
Academic School 
 
Personalized Imagery 
varies by recipient’s 
name (uImage) 

Academic School Image 
varies by Academic 
School  

Application Fee 
Discount Percent 

Recipient’s  
First name 
 
Academic 
School name 
 
 
Scholarship info 

 

 

 
Recipient’s 
first name 
 
Recipient’s 
Address 
 
Scholarship 
Info 

Color varies by 
Academic School 
 
Application Fee 
Discount Percent 
 
GPA averages chart 
varies by Academic 
School (uChart) 
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Variable Text 
Replace Static text with Dynamic text: 

• Recipient Name: Displays the Recipient’s first name.  
(See task  10 on page 16) 

• Academic school name: For each prospective student, the specific 
academic school which he or she inquired about is mentioned in the 
postcard.  
(See task  14 on page 21) 

• Recipient Address: The full address of each Recipient appears on the 
postcard. 

Calculate values based on recipient data and reformat Dynamic text: 
• Add a Rule for missing data: If there is no available data about a 

Recipient, regarding a desired academic school, the text EDU University is 
displayed.  
(See task  18 on page 36) 

• Show address in uppercase: The Recipient’s address.  
(See task  27 on page 59) 

• Locate and handle long text values 
(See task  11 on page 17) 

• Add a Rule to dynamically change the Application Fee Discount based 
on the chosen academic school: All prospects are offered an application 
fee discount depending on the academic school which the prospect is 
interested in:  
• Prospects who are interested in engineering are offered a 20% discount  
• The rest are offered a 15% discount 
(See task  17 on page 32) 

Variable Graphics 
Replace Static Images with Dynamic Images 

• Change graphics dynamically: Change Academic School Image based 
on the chosen school: The image reflects the academic school chosen by 
the prospect.  
(See task  15 on page 23) 

• Generate personalized graphics and change dynamically: The “Chalk 
Board” image includes the recipient’s first name in a hand-written welcome 
greeting.  
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Variable Layer Visibility 
Change the static design layout into a dynamic one: 

• Show/hide the layer containing Scholarship Information: Information 
about the scholarships that the university has to offer is shown only to 
prospects with an exceptional high grade point average.  
(See task  19 on page 40) 

Variable Styles 
Change static formatting styles to dynamic formatting: 

• Change object style: School Object Style: Colors in the postcard change 
according to the chosen academic school. 
(See task  20 on page 44) 

• Change character style: School Character Style: The character style 
includes the text color. An object with a dark color style requires a bright 
color for the text written on it, and vice versa. 
(See task  20 on page 44) 

Variable Data-driven Chart 
• Variable Data-driven: Recipients are shown the requested entry score to 

their preferred academic school for the past three years. 
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The Tutorial 
Below is the list of tasks that you will perform in this tutorial. Each task has a step-
by-step procedure, described below.  
If you want to print a Quick Task List to serve as a checklist you can refer to, as 
you follow the procedures through the tutorial, you may find a task index on page 
66. 
Install the uCreate Print plug-in before you start this tutorial. 
Note that uDirect requires Adobe InDesign CS6/CC/CC-2014. 
Read more about hardware and software requirements in Appendix A: Hardware 
and Software Requirements on page 68. 

Install the uCreate Print plug-in 
If you have not already done so, download and install the uCreate Print plug-in, 
from: 
http://www.xmpie.com/trial uCreate Print is a plug-in to InDesign, therefore: 
Make sure that InDesign is not running when you install the uCreate Print 
plug-in. Also, make sure that you have the uDirect Studio license key to 
activate the software and enable uImage and uChart. 
You will not see an uCreate Print shortcut icon within your Programs menu or on 
your desktop. Instead, the next time you launch InDesign; it will include the 
uCreate Print panel. 
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A. Getting Started  
1. Download the Tutorial files. 

a. Go to the http://www.xmpie.com/xmpie-tutorials  page, and then 
click the “uDirect with uImage “Open House” Tutorial” link.  

b. Fill in the download form and click “Submit.” 
c. Save the “uDirect_Studio_EDU_Tutorial.zip” file on your hard 

drive (If you prefer to unzip the file anywhere else in your file 
system, note the location, as it will be referenced several times 
during this tutorial).  

2. Unzip ”uDirect Studio Tutorial” into a new folder.    

3. Launch Adobe InDesign. 
From the “Window” menu, select “XMPie uCreate Print” to open the XMPie 
uCreate Print Panel (Figure 2): 

Figure 2: InDesign with the XMPie uCreate Print Panel 

 

Note:  If you do not see XMPie uCreate Print in the Window menu, 
uCreate Print has not been installed properly. If the uCreate Print panel displays 
an Activate button, you will need to activate the product to continue. 
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4. Display the uCreate Print Menu. 
Before you first use uCreate Print plug-in to edit an InDesign file, the uCreate 
Print panel shows an initial screen that  provides basic instructions on how to 
start using the product (as shown in Figure 3). 

Figure 3: XMPie uCreate Print panel: Initial Screen 

 
This tutorial uses the main features of the uCreate Print panel.  
To learn more about using the uCreate Print panel, read Appendix C: Learn to 
Use the uCreate Print Panel on page 71). 

5. Open the “EDU_Static.indd” InDesign file (Figure 4). 
You will find the file EDU_Static.indd in the uDirect Studio Tutorial folder 
(located where you unzipped these files in task  2). 
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Figure 4: The “EDU_Static” InDesign file  

 

6. Enable InDesign automatically locate links. 
In some cases, InDesign may display a message regarding missing links. If this 
happens, select Update Links and then Relink images on the InDesign Links 
panel menu, if needed. The required images are in the Resources folder. 

7. (Optional step) Change the fonts if needed . 
This document uses Myriad Pro and Impact fonts. If you do not have these 
fonts installed, you may need to replace the font to another that is installed on 
your computer.  
 

a. From the Type Menu, select Find Font….  
b. For any font in the document that is missing, select a different font 

family and style, then click Replace all.   
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8. Save the document with the new name. 
It is a best practice to leave the original document intact and save your working 
document after any initial changes, such as relinking images. Choose File > 
Save as from the menu. If needed, browse to your tutorial folder and name 
your working file “EDU_postcard.indd”. 

9. Link the postcard to a Data Source. 
To perform this instruction, you must first display the uCreate Print panel menu, 
by clicking the button ( ) at the top-right corner of the uCreate Print Panel. 
The uCreate Print panel menu is displayed (Figure 5). 

Figure 5: uCreate Print Panel Menu 

 
a. From the uCreate Print panel menu, select “Link to Data 

Source…” 
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The Select Data Source window is displayed (Figure 6).  
Note that this option is grayed out when there is no open Document.  

Figure 6: Select Data Source window 

 
 

b. Click the Browse… button and navigate to the tutorial folder, 
select “EDU_prospectives.csv”, and click “Open”. 
The Specify a Separator window is displayed (Figure 7): 

Figure 7: Specify a Separator window 

 
c. Click “OK”.  

In our case, the EDU_prospectives.csv Data Source uses a comma 
(,) separator, which is the default selection in this window. 
Once you link to a Data Source table, uCreate Print automatically 
creates an object for each of the table columns. The name of the 
object is the column header. These objects are known as Content 
Objects.   
The uCreate Print panel now displays a list of Content Objects 
(Figure 8). 
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Figure 8: uCreate Print panel, populated with EDU Content Objects 

 
d. Show the Content Object values 

The uCreate Print panel allows you to view the Content Object’s 
value per Recipient. To display the Content Object values, right-click 
any Content Object, or Cmd-click on a Mac, and select Show Data 
Column from the menu (Figure 9). 

Figure 9: Displaying the Data Column in the uCreate Print panel 
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B. Dynamic Text 
10. Replace the static Recipient name (“Mary”) with dynamic 

content containing the Recipient’s first name. 
In this task, you will replace the static Recipient name “Mary” with dynamic 
content, by replacing the text with the First Name Content Object (Figure 10). 
This action is called “tagging”.  
The first name appears on page 1 (front) (Figure 1) ‘Welcome’ text, in the 
scholarship text, as well as on page 2 (back). 

a. In the InDesign Tools panel, select the Type tool ( ). 
b. In the ‘Welcome’ text, highlight or double-click the text “Mary” 

(make sure you select the entire name). 
c. In the uCreate Print panel, scroll down the Content Objects List 

and double click the First Name Content Object. 

Figure 10: Replacing Static Text with Dynamic Text on the Welcome notice 

 
Note how the text Mary is instantly replaced with the text Jane from 
the EDU_prospectives.csv Data Source that your Design is 
currently linked to. Jane is the first of 99 records in this Data Source. 

d. See how your Design changes dynamically as you browse 
through your Recipient records (see more details about 
browsing records for preview in task  11). 
Click the Record Selector (up/down arrows ) at 
the bottom of the uCreate Print panel, to browse through the 
records of the EDU_prospectives.csv Data Source. Note how 
uCreate Print dynamically updates the Design with different first 
names.  
Learn more how to browse through Recipients in task  11 on page 17. 

e. Repeat this procedure to tag the static text “Mary” to First Name 
Content Object within the Scholarship text (below the Welcome 
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text) and on page 2 (back), at the top, with the First Name 
Content Object. 

Figure 11: Replacing Static Text with Dynamic Text page 2(back) 

 
Note how all names change as you scroll through Recipient records.  

11.  Previewing dynamic content 
To see how your Design changes dynamically as you browse through your 
Recipient records do the following: 
 

a. Scroll through the Data Source records. 
Click the up and down arrows in the Record Selector, and note the 
changes in the First Name and School Name Layer dynamic text. 
 

b. View a specific Recipient’s data, by typing that Recipient’s 
record number in the Record Selector. 
View the data of Recipient number 75 by typing “75” in the Record 
Selector. 

Figure 12: Viewing a Specific Recipients Data 

 
 

c. In the InDesign Tools panel, click and hold the “Preview” mode 

icon  , and select “Preview” from the menu to view the 
Dynamic Objects as they will appear after composition. You can 
also use the shortcut key "W" on your keyboard to toggle 
between Preview mode and Normal mode. 
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12. Locate and handle long text values 
In record 80, the Recipient First Name consists of two words: ‘Douglas William’.  
You can easily find the record with the longest value for the first name by right-
clicking on First Name and selecting the Go to Longest feature or you can 
browse to this record (see Figure 13). 

Figure 13: Go to Longest value 

 
If you browse to his record, you can see that in both the Welcome notice and 
the Scholarship note, on page 1 (front), the name does not fit into the text 
frame (see Figure 14) and both story boxes show an overflow (little red plus 
sign). 

Figure 14: Long Name at Recipient 80 

 
To fix overflow text in story boxes containing dynamic text, use the Copy 
Fitting option. This option enables you to reduce the font size, horizontal 
scaling of characters or the auto leading (vertical space between lines) to make 
any length of dynamic text fit its desired space.  
To apply the Copy Fitting option, do the following: 

a. Right-click on First Name in the uCreate Print panel or Cmd-
click on a Mac, choose “Go to Longest First Name”. This action 
brings you to record 80 (see Figure 13).  

b. Select the “Scholarship Note” text box and right-click the 
“Scholarship Text” box, or Cmd-click on a Mac. From the menu, 
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select “Dynamic Story Properties” > “Dynamic Story Length 
handling” (see Figure 15). 

Figure 15: Dynamic Story Length Menu 

 
The Dynamic Story Length Handling window is displayed. 

c. Select the “Copy Fit on” checkbox and make sure that 
“Overflow” is selected from the drop-down list. 

d. Select the text size checkbox and set the minimum size to 75% 
with a 2% step. 
The text will shrink in 2% increments (98%, 96% etc.) until it fits the 
text box, and will not shrink below 75% of its original size. 

Figure 16: Dynamic Story Length Handling window 

 
e. Click OK to close the window 
f. Repeat this task with the “Welcome” text box as well. 
g. Test the design using the Record Selector, to see how the 

overflowing text now shrinks to fit for record 80 and remains 
unchanged for other records. 
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The Recipient’s name should now fit into the box for all Recipients. 
Remember that Copy Fitting is applied per-text box and does not 
affect other text boxes. 

13. Rename the School  Content Object 
It is important to give Content Objects meaningful names, which accurately 
reflect their content and usage. For this purpose, you may occasionally need to 
rename a Content Object. 
In this example, you will rename the School Content Object.  
This Content Object indicates the Recipients’ requested school name: whether 
they requested information about the School of Engineering, the School of 
Medicine or the School of Law. Let us rename the School Content Object to 
School Name. 

a. In the Content Objects List, right-click the School Content 
Object, or Cmd-click on a Mac, and choose Rename “School”... 
from the menu.   

Figure 17: Renaming a Content Object (School) 

 
The Rename Content Object window is displayed. 

Figure 18: Rename Content Object window (School) 
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b. Rename the Content Object 
In the New Name field, type School Name and click Rename. 
The Content Object’s name is updated in the Content Objects list. 

14. Replace the static school name “Medicine” with the 
School Name Content Object. 

In this task, you will tag the text with the School Name Content Object  
(Figure 19). The school name appears on page 1 (front) and on page 2 (back), 
(Figure 1). In the InDesign Tools panel, select the Type tool. 

a. In the “Welcome” text box, highlight or double-click the text 
“Medicine”. 
Make sure you select the entire name. 
 

b. In the uCreate Print panel, scroll down the Content Objects List 
and double-click the School Name Content Object. 

Figure 19: Replacing Static Text with Dynamic Text on the Welcome notice 

 
If you are still viewing Recipient record 80, the text Medicine is 
instantly replaced with the text Engineering. Other Recipients may 
have a different school name. 

c. See how your Design changes dynamically as you browse 
through your Recipient records.  
Browse through EDU_prospectives.csv Data Source records by 
clicking the Record Selector (up/down arrows ). 

d. Repeat this procedure to tag the rest of the text with the School 
Name Content Object. 
The school name appears: 

• Within the Schedule text at the bottom of page 1 (front) before the 
word Advisors. 

• On page 2 (back) – after “As an applicant to” (see Figure 20) 
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Figure 20: Replacing Static Text with Dynamic Text on the event schedule 
part on page 1 (front), and in the second part of text on page 2 (back) 

     
e. Browse through the Recipients and see the school name change. 

 Note: A Recipient school name may be either “Engineering”, “Medicine”, 
“Law” or empty. Handling ‘empty’ cases, when a Recipient with no data 
about their school, will be completed at a later stage (see task  18 on 
page 36 
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C. Dynamic Graphics 
15. Replace the static school image with a dynamic graphic. 

To complete this task, duplicate the existing Content Object School Name and 
change the duplicated Content Object’s type to Graphic. Since the filenames of 
the images (Assets) for each school is identical to the school name within the 
data (see Appendix B: uDirect Studio Tutorial Materials Specifications on page 
69), uCreate Print automatically locates the right image. 

 Note: uCreate Print automatically searches images that are within a folder 
named “Assets”, located in the same folder/directory structure where the 
data is found. When doing other VDP projects, if your folder/directory 
structure is different, you can use the Set Assets Folder option in the 
uCreate Print panel menu.   

a. Duplicate the School Name Content Object 
In the Content Object list, right-click on the School Name Content 
Object, or Cmd-click on a Mac, and choose Duplicate “School 
Name”... from the menu.  

Figure 21: Duplicating a Content Object (School Name) 

 
The new School Name Copy Content Object is available now at the 
end of the Content Objects list. 
 

b. To give the Content Object an appropriate name, right-click the 
School Name copy Content Object in the Content Object list, or 
Cmd-click on a Mac, and choose “Rename ‘School Name 
copy’... ” from the menu. 
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The Rename Content Object window is displayed. 
c. Rename the Content Object: 

In the New Name field, type School Image and click Rename. 
The Content Object’s name is updated in the Content Objects list. 

d. Change the object type of the School Image Content Object from 
Text to Graphic  
Content Objects have several different possible types based on the 
type of object they represent in the Design, for example: Text, 
Graphic, Visibility, etc. By default, all Content Objects are created as 
Text Content Objects, and their type can be easily changed as 
needed. 
In this case, you want the School Image to show the image of the 
Recipient’s school, so first you need to change its type from Text to 
Graphic. 

i. In the Content Objects List, right- click the School Image, or 
Cmd-click on a Mac, and choose “Type > Graphic” (See 
Figure 22) 

Figure 22: Changing the Content Object Type 
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In the uCreate Print panel, the icon of the School Image 
Content Object changes from Text ( ) to Graphic ( ). 
 

e. Replace the Static Graphic (the middle image) with a Dynamic 
Graphic, using the School Image Content Object. 
The value of a Graphic Content Object is the file name of a specific 
Asset: a graphic file that changes per Recipient. Any Campaign that 
uses variable graphics needs to have an Assets folder that contains 
the Asset files for its variable graphics.  
In this case, there are 4 Assets that may be used as the Recipient’s 
School Image:  
• Engineering.jpg - for the School of Engineering,  
• Medicine.jpg - for the School of Medicine 
• Law.jpg - for the School of Law  
• General.jpg - for Recipients that don’t have a requested school 

(will be configured in task  18 on page 36).  
 
The value in the School column of the Campaign’s Data Source, 
EDU_prospectives.csv, determines the file name of the Asset to be 
used for each Recipient.  
uCreate Print automatically recognizes the graphic file’s format; 
therefore the value in the Data Source does not need to include the 
file extension (in this case, .jpg). 

i. Using the black arrow (Select Tool on the InDesign Tools 
panel), select the “School Image” (the image in the middle of 
page 1(front) – see Figure 23). 

ii. In the Content Object list, double-click School Image. 
The School Image now reflects the Asset assigned to the current 
Recipient.  
For example, Recipient 1 has school of Engineering, while Recipient 
2 has school of Medicine. 
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Figure 23: Tagging the image to School Image Content Object 

 

 Note: This procedure of creating a Graphic Content Object from a Text 
Content Object works only when the image file name (with or without its 
extension, for example, .jpg) is identical to the text supplied by the data. 
This is true in this Campaign. The image names are: Engineering.jpg, 
Medicine.jpg and Law.jpg, and the values in the “School” column (within 
the data, EDU_Prospective.cvs) are: Engineering, Medicine and Law. 
uCreate Print can also easily handle cases where the image file name is 
not identical by creating rules that assign a specific image to a specific 
value in your data. You can see this later in task  28 on page 60. If the 
following image appears (Figure 24), it means that InDesign cannot locate 
the file.   

 
iii. (Optional) To point uCreate Print at the location of your 

Assets folder, open the uCreate Print panel menu, choose 
Set Assets Folder… and browse to the location of your 
Assets folder. 

Figure 24: Placement Image for missing Assets 

 

Page 26 of 87 
 
 



     uDirect Studio Version 7.1   

 
 

f. Set the “Fit and Transform” Mode of a Graphic Content Object 
(School Image). 
If you browse through the recipients, you can see (Figure 25) that 
each school image has a different size. You would like all the images 
to be resized automatically, so that they fit nicely into the same frame.  

Figure 25 - Image assets of different size need to be managed 

     
 
uCreate Print supports several Fitting Modes for dynamic graphic 
frames. To see the current Fitting Mode of a tagged graphic frame, 
you need to view the file in Normal mode in the InDesign Tools panel, 
and the Highlight Dynamic Objects option is selected in the 
uCreate Print panel (Figure 27).  
The School Image graphic frame is currently set to Maintain 
Transformation, while the most appropriate setting for our use is Fill 
Proportionally. To change the Fit and Transform options, proceed 
as follows: 

i. Right-click the School Image, or Cmd-click on a Mac, and 
choose “Dynamic Graphic Properties” from the menu… 

The Dynamic Graphic Properties window is displayed. 

Figure 26: Dynamic Graphic Properties - School Image 
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ii. From the “Fit and Transform” drop-down list, choose “Fill 
proportionally & Centered” and click “OK”.  

Figure 27: Highlight Dynamic Objects 

    

 Note: Take a look at Recipient 6. In the School Name Content Object, there 
is no value in the Data column. Therefore, the new School Image Content 
Object is also empty, and there is no image in the School Image 
placeholder in the postcard. You will handle these special cases by 
adding a special rule in at later stage in task  28 on page 60. 
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D.  Rule Editor 
So far, you have defined Content Objects based on two Attributes: Name and Type. 
In addition, Content Objects are defined by their Business Rule (Rule, in short).  A 
Rule is an expression that is part of the Campaign Logic that determines how to 
calculate the Content Object value for each Recipient. 
Below are the tasks to be performed using the Rule Editor. 
To learn more about Rule types and about using the Rule Editor, read Appendix 
D: Learn to use the Rule Editor  on page 73). 

Edit Content Object to be displayed using UPPERCASE. 

16. Create uppercase First Name Content Object to be used 
in the Recipient’s address. 

This task will set the First Name in the Recipient address to appear in 
uppercase (JANE instead of Jane).  

a. Duplicate the First Name Content Object 
In the Content Object list, right-click the First Name Content Object, 
or Cmd-click on a Mac, and choose Duplicate “First Name… from 
the menu. The new First Name copy Content Object is available now 
at the end of the Content Object list. 

b.  Launch the Rule Editor 
In the Content Object list, right-click the First Name copy Content 
Object, or Cmd-click on a Mac, and then select Edit Rule… from the 
menu. 
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Figure 28: Editing a Content Object’s Rule 

 
The Rule Editor window is displayed. 

Figure 29: Edit Rule - Rule editor window 

 
 

c. Rename the Rule to First Name Upper. 
In the name field, enter First Name Upper. 
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d. Under Rule, from the second drop-down list, select 
“UPPERCASE” from the list of common functions (See Figure 
30). 
Functions perform specific tasks and often require specific 
information to perform that task. The specific information required by 
a function is called a parameter. Parameters are always listed in 
order (when more than one) and between the parentheses of a 
function.  
In this case, the UPPERCASE() function needs to know what to 
convert to uppercase letters. The value [T] First Name (the First 
Name field from the Data Source) became a parameter when it 
moved automatically into the parentheses.   
Note that you may preview the Recipient data in the Preview pane of 
the Rule Editor window (see Figure 30). The Recipients number is 
also shown and you can browse to see how other records would be 
displayed by clicking the arrows. 

Figure 30: Edit Content Object First Name copy—Updated Rule 

 
e. Click “OK” to close this window. 

Browse through recipients and see how the Recipient data is 
changed in the uCreate Print panel in the Data Column (The Data 
Column was added to the panel in task  9 on page 15) 

f. Repeat the above steps to duplicate the Last Name Content 
Object, and create a Last Name Upper Content Object that has 
the last name in uppercase. 
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g. Tag the first name in the address line on page 2 (the card’s 
back), with the First Name UPPER Content Object. 
Using InDesign Type tool, select the first name in the address line 
(page 2 (back)), and then double-click the First Name Upper Content 
Object. 

h. Tag the last name in the address with the Last Name Upper 
Content Object. 
Using InDesign Type tool, select the last name in the address line, 
and then double-click the Last Name Upper Content Object. 
The Address is now personalized with a first name and a last name 
that appear in uppercase, as shown in Figure 31. 

Figure 31: The capitalized name (First and Last Names in Uppercase) 

 

Create conditional Rules using the Rule Editor 
Conditional Rules allow you to determine a Content Object’s value using a 
logical condition. Conditions are written as “is equal to” (=), “is not equal to” 
(<>), “is greater than” (>), or “is less than” (<), which makes every condition 
value “true” or “false”.  
If     <condition is met>  

Then       <if true show value A>   

Otherwise   <if false show value B>. 

17. Give different discount to each school using Fee Discount 
Content Object 

In this case, you will use a conditional Rule to determine the value of the 
Application fee Discount Content Object. This value depends on the value of 
the School field in the Data Source: 
The Rule you would like to create is: 

If    the value of [School] is engineering  

Then   for the Discount show 20%.  

Otherwise   show 15%.  
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You want to connect between the school name and the discount value. 
 [School] is the value the Recipient has in the School column in the Data 
Source.   
To enter values into a Rule expression, you select from the drop-down list 
either “String” (=text) or “Number” (see Figure 32). Both options will give us a 
box to enter a value to test (i.e. “Engineering”) or a value for the Content Object 
display (i.e. “20” or “15”). You can only enter numeric values into a Number 
box.  

Figure 32: Defined Discount Content Object Rule  
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Here is how to create a conditional Rule that follows this definition: 
a. Create a New Content Object 

In the Content Object list, right-click anywhere, or Cmd-click on a 
Mac, and select New Content Object… from the menu.  

Figure 33: Select New Content Object from the panel menu 

 
The Rule Editor’s New Content Object window is displayed. 

b. In the Name field, name the New Content Object Discount. 
c. Set the first drop-down list to ‘If’.  

This will define this Rule as a conditional Rule. 
A simple condition consists of three lines. You will edit these three 
lines in the following steps. 

d. Edit the first line (starts with “If”). 
The “If” (conditional) part of the conditional Rule is always a 
statement that is either true or false for each Recipient. In this case, 
you want to use the following statement: “If the Recipient’s school is 
Engineering”. In a Rule, this is specified by “If School = Engineering”. 
Here is how to do it:  

i. Select [T] School from the second drop-down list. This is the 
School column from the Data Source, the Recipient’s school. 

ii. Select “=” from the next drop-down list. 

iii. Select “String” from the following drop-down list, if needed 

iv. In the empty box that follows, type the school name: 
“Engineering”. 
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 Note: Please make sure to type the school name as shown in the 
instructions since this field is case sensitive. The school name in the data 
was entered in a title case (first letter capitalized). 

e. Edit the second line (starts with “Then value”). 
The “Then” part of the conditional Rule specifies the value for the 
Content Object when the condition defined in the “If” part above is 
true.  
The condition here is whether or not the Recipient’s School is 
Engineering. Thus, when the Recipient’s School is Engineering, the 
condition above is true.  
When the Recipient’s School is Engineering, the discount should be 
20. Therefore, this line should say: “then the discount is 20”. Here is 
how to specify it: 

i. Select “Number” from the first drop-down list. 
ii. In the empty box that follows, type “20”. 

 
f. Edit the third line (starts with “Else value”). 

The “Else” part of the conditional Rule specifies the value for the 
Content Object when the condition defined in the “If” part above is 
false.  
The condition here is, again, whether or not the Recipient’s School is 
Engineering. Thus, when the Recipient’s School is not Engineering, 
the condition above is false.  
When the Recipient’s School is not Engineering, the discount should 
be 15. Therefore, this line should say: “else the discount is 15”. Here 
is how to specify it:  

i. Select “Number” from the second drop-down list. 
ii. In the empty box that follows, type “15”. 

 
g. Make sure your Rule is defined as shown in Figure 32 and then 

click “OK” to close this window. 
h. On the first page of the postcard (bottom left corner), tag the 

static discount “15” with the Discount Content Object you have 
just created. 
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i. On the second page of the postcard in the third paragraph, tag 
the static discount “15” with the Discount Content Object (see 
Figure 34 ). 

Figure 34: Discount appearing on the card’s back (comparing records 1 and 6) 

 
j. Browse through different Recipients, and watch the application 

fee discounts vary. 
As defined in the conditional rule, a Recipient’s fee discount is either 
“20%” (Engineering) or “15%” (non-Engineering). 

18. Adjust the school name to fit an empty data situation. 
Right now, the ‘Welcome’ notice in the front of the postcard shows one of these 
messages for each Recipient, based on their selected school: 

• “Welcome to the School of Engineering”  

• “Welcome to the School of Medicine” 

• “Welcome to the School of Law” 
Recipients, for whom the School column in the Data Source is empty, get 
“Welcome to the School of”. Check Recipient (record) 6 to see an example. 
Obviously, this should be changed. 
In this step:  
You will delete ‘The School of’ from the card, and for Recipients that have a 
value in the School column, you will add “the School of” before the School 
name, as part of the rule, while for Recipients who do not have a value in the 
School column, it will show “Welcome to EDU University”. 
The rule you would like to create is: 

If   [School] is not empty  

Then   show the School of [School]  
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Otherwise show EDU University 

Where [School] is the value the Recipient has in the School column in the 
Data Source. 

Figure 35: Rule Editor- “School Name" – The edited Content Object Rule 

 
Here is how to create a conditional Rule that follows this definition: 

a. Before you define the rule, erase “the School of” from the 
School name appearances (see Figure 19 and Figure 20 on page 
21) in the following pages: 

i. page 1 (front) on the Welcome notice 
ii. page 1 (front) in the last line of Schedule section  
iii. page 2 (back) - in the main text body 

b. Modify the School Name Content Object Rule. 
In the Content Object list, right-click or Cmd-click the Matched School 
Name Content Object and choose Edit Rule from the menu.  
The Rule Editor window is displayed. 

c. Select the ‘Extended Functions’ checkbox. 
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The Rule Editor drop-down list will include additional options that you 
will need in order to define this Rule. 

Figure 36: Rule Editor- Extended function checkbox 

 
d. Set the first drop-down list to “if” instead of “Value=” 
e. Edit the first line: ”If" (If school field is not empty) 

i. Set the first drop-down list to “If”. 
ii. Select “Trim” in the second drop-down list. 

The Trim function removes all leading and trailing spaces from 
the field passed to it as a parameter. For example, if a field 
value is “   John”, trimming it will return the value “John”. 
Similarly, trimming the value “Maria    ” will return the value 
“Maria”. 
If a field contains only spaces, uCreate Print will not recognize 
it as empty. Therefore trimming a field’s extra spaces assists 
uCreate Print in identifying empty fields, even when they 
contain spaces and are not really empty.  
You will find the Trim option in the second drop-down list.  

iii. Set the third drop-down list to [T]School. 
iv. Change the fifth drop-down list to “<>” not equal to (if needed). 
v. Select “String” from the next drop-down list (if needed). 
vi. Leave the following string box blank. 

By blank (or empty) you mean “no value appears in the data 
source”. 

f. Edit the second line: “Then Value =” (then show ‘the School of 
[School]’). 

i. To add “the School of” before the school name, set the first 
drop-down list to “String”. 

ii. Type the string you would like to show : “the School of ”. 
(Make sure you leave a space after “of”, to come before the 
next word). 

iii. Select the ampersand (‘&) from the next drop-down list, 
meaning you want to add to the previous string to the following 
string. 
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Adding two strings together is called concatenation. 

iv. Select “[T]School” in the next drop-down list  (close to the 
bottom of the list). 

 
g. Edit the third line: “Else Value=” (otherwise, show ‘EDU 

University’). 
i. Make sure “String” is selected in the second drop-down list. 
ii. Type “EDU University” in the next string box. 

h. Make sure your School Name Rule is set as shown in Figure 35, 
and then click “OK” to close this window. 

i. Browse through school names of different Recipient. 
Note that a Recipient school name may be either “Engineering”, 
“Medicine”, “Law” or, if no data available in the linked Data Source, 
“EDU University”. A Recipient that does not have a value set in the 
School column can be found in Recipient 6, among others. 
See how “the School of” is added to the school name, and how the 
school name changes as configured in the rule. You may see this 
change in the Welcome notice and in the schedule on page 1 (front) 
and in the message area of page 2 (back). 
A similar condition should be defined for the school image. You will 
complete this task in a later stage (see task  28 on page 60). 
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E. Dynamically Show and Hide Layers 
19. Show and hide the “Scholarship” Layer according to the 

student’s grade average. 
You would like to show the scholarship layer only to those students who are 
eligible, namely those students whose grade point average (GPA) is higher 
than 85%. The ability to show or hide a layer is done using Visibility Content 
Objects. Visibility Content Objects can be used to show or hide layers and/or 
page spread.  

 
Layers 
Layers can be shown (on) or hidden (off) by toggling the visibility (the eye 
symbol on the layer, see Figure 37). If you have not tried before, left-click the 
mouse on the eye icon next to the layer to turn the Scholarship layer on and off. 
When applied to a layer (known as assigning), a Visibility Content Object and 
its rule (see rule samples below) control if a layer should be displayed or 
hidden. When a layer is hidden for a specific recipient it will not be printed.   

Figure 37: Layers panel, Show/Hide layers 

 
Controlling the visibility of a layer is very useful when you want to change the 
design layout for a group of recipients based on your data.  
Visibility Content Objects for Layers 
Visibility Content Objects are easily assigned to layers by selecting the layer (in 
the Layers panel) and then double-clicking the Visibility Content Object or using 
Dynamic Layer Visibility option found in the Layers panel menu (select 
Dynamic Layer Visibility:  all Visibility Content Objects set in the document 
will appear in a submenu for selection).  
Each layer can only have one Visibility Content Object assigned to it. However, 
Visibility Content Objects can be assigned to multiple layers. 
Because the nature of a layer is to be visible or not, the rule for visibility is 
always a conditional statement. This means that only Visibility Content Objects 
rules can use a shorten statement of “Is visible If”, as well as the use of a 
regular conditional statement “If”. 
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A quick example assigns “true/false” based on the condition:  

Is visible If: SomeDataField = SomeDataValue  

If the two values are the same, then the value is true, otherwise false 
 

In this step: 
In this step, you will use the shortened version of the condition (Is visible if) 
and you will modify the visibility requirements of the Recipient scholarship.  
The scholarship message has been designed on an individual layer, named 
Scholarship. 
One of the requirements in the “uDirect Studio Tutorial” Campaign brief is that 
the scholarship message should be shown only to Recipients who have a 
grade point average (GPA) higher than 85. This information appears in the 
GradeAvg Data Source column. 
The rule you would like to define is: 
If the Recipient’s ‘GradeAvg’ is higher than 85, show the ‘Scholarship’ layer, 
otherwise, hide it. You do not have to specify when to hide it, only when to 
show it and it will be automatically hidden in all other cases.  

Figure 38: Rule Editor--“Show Scholarship"-- Filled Visibility Content Object Rule 
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Here is how to create a conditional Rule that follows this definition: 
a. In the Content Object list, right-click, or Cmd-click on a Mac, and 

choose “New Content Object” from the menu.  
The Rule Editor’s New Content Object window is displayed. 

b. In the “Name” text box, type “Show Scholarship”. 
c. From the “Type” drop-down list, choose “Visibility”. 

Note the changes in the Rule section: the first drop-down list is set by 
default to a special condition, Is visible if. 

d. In the ‘Is visible if’ line, on the second drop-down list, select 
GradeAvg. 

e. From the operations drop-down list, select the “>” operator 
(which means “greater than”). 

f. From the next drop-down list, select “Number” and then type 
the number “85”. 

g. Make sure your Show Scholarship Rule is set as shown in 
Figure 38, and then click “OK” to close this window. 
The Show Scholarship Visibility Content Object is added at the 
bottom of the Content Object list, indicated by an “eye” icon . 

h. Select the ‘Scholarship’ layer in InDesign’s Layers panel 
The Layers Panel is displayed by choosing Window > Layers from 
the menu. The Scholarship layer has a designated green color 
which is indicated by the icon of the active layer in the uCreate Print 
Panel. 

i. Tag Scholarship layer with the Show Scholarship Content 
Object by double clicking the Content Object name.  

Page 42 of 87 
 
 



     uDirect Studio Version 7.1   

 
 

Figure 39: Rule Editor-Show Scholarship Visibility Content Object Rule 

 
j. Click “Assign” in the opened window (see Figure 40). See that 

the layer green icon in the uCreate Print panel was changed to have 
the Visibility eye icon on it. 

Figure 40: Visibility Assign Window 

 
k. Browse through different Recipients. See that Recipient 1 does 

not have the scholarship note while Recipient 2 does. 
You can find the scholarship layer appearances on page 1 (front), in 
the gray strip, and on page 2 (back) above the bolded “We hope you 
enjoy…” text line which is above the chart. 
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F. Dynamically Change Style 
You would like to show a different looking design to Recipients, based on their 
chosen school. You want to have different background colors for each school, so 
that the colors match the school image. You will dynamically change the 
background color, and then dynamically change the text color to match the new 
background color. 
To do this, perform the following steps: 

 
1. Create InDesign Object Styles, one for each school. Each Object Style applies 

the correct background color for the school. 
 

2. Create a matching InDesign Character Style for each of the Object Styles 
created in step 1. The character style sets the text color to match the 
background color. 

20. Create a Style Content Object to change background 
color (Object Style) 
As stated above, the required Object Styles have been predefined in the 
design you are editing. You can see them in the Object Styles panel: 
(Window > Styles > Object Styles). 

• General- Blue background, to be used when no information available on the 
Data Source about the required school. 

• Engineering- Green background, to be used as the Engineering’s school 
background. 

• Medicine- Light blue background, to be used as the Medicine’s school 
background. 

• Law- Brown background, to be used as the Law’s school background. 
 
The rule you would like to set is: 
If     School is Medicine,  

then     Apply Object Style ‘Medicine’. 

If     School is Engineering,  

then   Apply Object Style ‘Engineering’. 

If     School is Law,  

then   Apply Object Style ‘Law’. 

otherwise  show ‘General’ object style. 
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Figure 41: Rule Editor-Edited “Background Color Scheme”- Style Content Object Rule 

 
Here is how to create a conditional Rule that follows this definition: 

a. Right-click, or Cmd-click on a Mac, the Content Object panel and 
choose “New Content Object…” from the menu.  
A New Rule Editor window is opened. 

b. In the “Name” text box, type “Background Color Scheme”. 
c. From the “Type” drop-down list, choose “Style”. 

The Rule Editor Changes the first drop-down list label from: ‘Value =’ 
to ‘Apply Style’. 

d. Edit the first line (create “If school is Medicine”). 
i. Set the First Apply style drop-down list to If. 
ii. Change the second drop-down list to [T] School. 
iii. Set the following drop-down list to “=” 
iv. Set the following drop-down list to String. 
v. Type “Medicine” in the empty box. 

e. Edit the 2nd line (create “then Apply Object Style ‘Medicine’”). 
i. Change the drop-down list from None [OC] to Medicine [O] 

f. Edit the 3rd line. 
i. Change first drop-down list from Else Apply Style to Else if. 
ii. Change the second drop-down list to [T] School. 
iii. Set the following drop-down list to “=” 
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iv. Set the following drop-down list to String. 
v. Write “Engineering” in the following text box. 

g. Edit the 4th line, ‘Then’ (“then apply Engineering Object style”). 
i. Change the drop-down list from None [OC] to Engineering [O]. 

h. Repeat steps f and g for the School of Law. 
i. Edit the last ‘Else’ line. (“Else, apply General Object style”). 

i. Change the drop-down list from None [OC] to General [O]. 
j. Make sure your Rule is set as shown in Figure 41. 
k. Click “OK” to close the Rule Editor Window. (Note that the 

Content Object icon is now changed to a Style icon ). 
l. Tag all the light blue background objects with the new 

Background Color Scheme Content Object: select a colored 
area and double-click the Background Color Scheme Style 
Content Object (see their location on the card on Figure 42). 

Figure 42: Objects to be connected to the Background Color Scheme Content 
Object 

 

  

 

Background Color 
Scheme Objects 
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m. Test the design by browsing through records of Recipients with 
different school requests (for example, records 1, 2, 5 or 6). 

You can scroll through the records, or enter the desired record number 
to view the different backgrounds. 

 Note: InDesign styles can include both Character and Object styles. uCreate 
Print displays it with [O] for Object styles, and [C] for Character style, next 
to its name. In the drop-down list after the ‘Then Apply Style’ one, you will 
see both Object styles and Character styles. To unapply a style, simply 
select the object, right click or Cmd-click on Mac, and choose Unapply 
Style Content Object.  
 
The character styles need to be changed as well.  This is done in another 
step.  
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G. Use uImage to Generate Dynamic Graphics. 
21. Create uImage Graphic Content Object (chalk board). 
In this task, you will create a new Content Object that converts a static Photoshop 
document into a dynamic template, using the uImage package. 
In this tutorial, you are provided with a uImage package that contains a special 
version of the “Simple Math” template, taken from XMPie Marketplace 
(marketplace.xmpie.com). 
For information about how to adjust a Photoshop image file to work with uImage 
and to learn more about creating a uImage package read Appendix E: Prepare a 
Photoshop file to work with uImage, and pack it as a uImage package  

a. Right-click the uCreate Print panel, or Cmd-click on a Mac, and 
click ‘Create New Content Object’ 
The New Content Object dialog is displayed (See Figure 43) 

Figure 43: Rule Editor – New Content Object; uImageWelcome 

  
b. Type ‘uImageWelcome’ in the Name field. 
c. From Type drop-down list, select “Graphic”. 
d. Check the “Extended Functions” checkbox. 
e. In the Rule definition section- Select uImagePhoto from the 

Functions drop-down list. 
f. Click the “Package…” button. 
g. The “uImage Settings” dialog box is displayed (Figure 44): 
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Figure 44: Rule Editor – Complete Content Object configuration; uImage 
Welcome 

  
 

h. Click “Browse” next to the Template Package field, navigate to 
your tutorial folder and from the uImageTemplate folder, select 
EDU.dpkg, and click “Open”. 
The template type and the Template Document name are auto-filled 
using the selected template package. 

i. Under the Data section, the text that represents the variable data 
used in the selected template package (uImage tag) appears in 
the Parameters pane (Figure 45).  
If the image tag matches the data field in the linked datasource, 
uCreate Print automatically uses the image tag as the tag value. To 
change or to make sure it does, select the uImage tag and click the 
Customize… button. The image tag rule is opened. You may change 
or confirm the value selected for this tag. 
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Figure 45: uImage Settings – Data, uImage Parameters 

 
In the “Advanced Settings” pane, you can see additional options. 

Figure 46: Advanced Settings 

 
j. In the “Output Format” list, select the “JPEG” file format and 

click the "Properties" button. The following dialog box is 
displayed: 

Figure 47: JPEG Properties 

 
Here, you can modify the JPG quality if desired. The settings on this 
dialog will change depending on the selected Output Format. 

k. The Output Folder locates the folder where the created uImage 
outputs are saved. You may use the default location. This will 
set a folder named Output in the tutorial folder. If you want to 
use a specific folder, click “Browse” next to Output Folder and 
navigate to the requested folder.  
The uImage output folder is where the generated personalized 
images files are saved so that you can see the template change 
dynamically as you scroll through the records. 
By default, the output file name is automatic and is created once per 
record name - meaning no duplicates are created. For example, in 
our EDU campaign, only the first name is changed in the image using 
uImage. All users that have the same first name will therefore have 
the same picture.  
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It is important to remember that if a change is made to the uImage 
rule- all outputs created previously must be erased in order to be 
recreated. 

l. In the “uImage Settings” dialog box, click “OK.” 
m. Tag static graphic frame (girl writing on the blackboard) with a 

uImage Graphic Content Object (“uImageWelcome”). 
To incorporate the personalized image into the document, select the 
image (girl writing on blackboard) with the Select tool (black arrow), 
then double-click the uImageWelcome Content Object you created 
above. 

n. Browse through recipients records and see how the dynamic 
template changes dynamically.  
As you begin to scroll through the records, Photoshop opens 
automatically (if it is not already open) to generate the output uImage 
file for each recipient/record. Browsing may take some time, 
particularly for the first recipient, as Photoshop loads. Browsing 
through the subsequent records take less time as Photoshop is 
already loaded. 

For more information about creating a uImage package in Photoshop, read 
Appendix E: Prepare a Photoshop file to work with uImage, and pack it as a 
uImage package  
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H. Create a Chart to Display Dynamic Data Related to the 
Recipient. 

One of the easiest ways to present tabular data is to visually show that data using 
a chart or graph.  In this tutorial, you are required to show the GPA requirements of 
each school for the last three years. 
Creating a chart with uDirect Studio is a two-part process.  
First Part – Create a Table Content Object (See task  22) 
To create a Table Content Object, you need a second Data Source that is related 
to the recipient’s (first) Data Source.  This secondary Data Source has two 
requirements:  
1) It must contain a column whose data values relate back to a particular column 

in the recipient data. This column or field is often called a key field.   
In this tutorial, the EDU_Scores.csv (data file) has a column called School 
Name which matches the value of School column in the 
EDU_prospectives.csv.  

2) The data must be entered in a particular format, the best layout being the Row 
form. The Column form will only work in certain instances. Using the data for 
this tutorial as an example, here are the ways data can be entered.   
Data in Row Form 
This data layout will work in uDirect Studio and other XMPie products. This is 
the recommended layout for creating pie charts. 
 

School Name Year Score 
Medicine 2010 85 
Medicine 2011 87 
Medicine 2012 93 
Engineering  2010 81 
Engineering 2011 81 
(and so on) 

Data in Column Form 
This data layout will work in uDirect Studio only for bar charts whose bars are in 
a unique color. This layout also works using special QLingo programming, 
usually done in the uPlan module that comes with uDirect Premier. 
 

School Scores for  Scores for Scores for 
Name 2010 2011  2012 
Medicine 85 87 93 
Engineering  81 81 85 
(and so on) 
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Second Part – Place the Table Content object in to a Graphic Frame  
Placing a Table Content Object in a Text Frame gives you a Dynamic Table that 
can be formatted with InDesign table formatting options. Check out Chapter 2 of 
the uCreate Print User guide for more information. 
Placing a Table Content Object in to a Graphic Frame converts the table data in 
chart data, which can be formatted using Dynamic Chart Properties options.  
 

22. Create a Table Content Object (Cost Summary) 
The first step is to create a Table Content Object using the EDU_Score.csv file as 
your Data Source. 

Figure 48: Complete Table Content Object (‘uChart’) 

 
 

a. Right-click anywhere in the uCreate Print panel or Cmd-click on 
a Mac and select “New Content Object…” from the context 
menu. 
The New Content Object dialog is displayed  

b. In the “Name” field, type “uChart”. 
c. From the “Type” drop-down list, select “Table”. 
d. In the “Table Structure and Data Information” section:  

i. Click the Browse button next to the Source box, navigate to 
your Tutorial folder and select the EDU_Scores.csv file, and 
click Open.  
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ii. From the Table Field drop-down list, select School Name (if 
not already selected).  

iii. From the Equals Recipient Field drop-down list, select 
School. 

Selecting these fields gives the system the way to connect between 
the two data tables used in this document. In our case, the school 
name in the EDU_scores.cvs equals the school fields in the 
EDU_Prospectives.csv data file, therefore connecting these two 
fields instructs uCreate Print to find the relevant entry score for each 
recipient for his requested school. 

e. Click “OK” to close the dialog. 
 

23. Create a Dynamic uChart Chart by tagging a Graphic 
Frame with a Table Content Object 

The next step is to create a dynamic chart by tagging a graphic frame with a Table 
Content object within the postcard. 

a. In InDesign, select the placeholder frame in the area allocated to 
the “Bar Chart”. 

b. In the uCreate Print panel, double-click the uChart Content 
Object to insert the Table Content Object into the design. 
The placeholder frame displays a pie chart indicating that the frame 
has been associated with the selected Table Content Object; the pie 
chart does not reflect the Table Content Object data at this time. 

 

24. Define uChart Properties 
Once the Table Content Object has been placed in its position within the postcard, 
you need to specify how the Table Content Object data should be presented in this 
graphic. 

a. Right-click on the placeholder frame or Cmd-click on a Mac, and 
select uChart properties. 

Figure 49: uChart properties menu item 
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The uChart Properties dialog is displayed (See Figure 50) 

Figure 50: Complete uChart properties dialog 
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b. From the “Type” drop-down list, select “Column Chart”. 
c. From the Colors list, double click the checkbox of the orange 

CMYK color: C=13 M=57 Y=74 K=0. 
The Series Color Assignment dialog is opened (see Figure 51) 

Figure 51: Series Color assignment 

 
d. Select the score in the series drop-down to define which data 

column displays in the chart using this color, type the display 
name you want it to have, and click “OK” to close the Series 
Color Assignment window. 

e. In the “Options” section,  
i. Select font as “Myriad Pro” (or a comparable font) and 10pt 

size.  
f. Make sure “None” is selected in the “Legend” section. 
g. Select the “3D Effect,” “Show Bar Values” and “Show Grid” 

checkboxes to display these options for this chart. 
h. Change the “Annotate” drop-down to “Both Axes”, and the “X-

Series” to year. 
i. In the “Chart Options” pane, enter the following commands:  

(you can delete the note or leave it, each command needs to be 
on a line of its own) 
/HighValue 100 

/LowValue 60 

/AxisColor LightGray 

/GridLineColor DarkerGray 

/BarGap 2.5 

/ValueColor White 

/PrintFloor Yes 

/OutlineColor DarkerRed 

/ValueLocation Head 

/ChartValueSize 2 
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These commands are used to define the visual display of the chart. 
See Appendix B of the uCreate Print User Guide for a list of and 
explanation of all the uChart commands. 

j. Click “Apply” to apply the parameters to the bar chart and “OK” 
to close the dialog. 
The column chart displays as you have defined in the uChart 
Properties dialog (See Figure 52). 

Figure 52: uDirect Studio Bar Chart 

 
You now need to resize the chart and reposition it within the frame. 
Make sure the reference point is in the top-left hand corner. 
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Do-It-Yourself Section 

All tasks have a reference back to the corresponding step in the previous sections. 
If you are unsure how to complete a task, use this reference to review its 
corresponding step. 

 

I. Tutorial Revision- Address Block and School Image 
The following tasks (steps  25- 28) are required to finish the personalization of the 
uDirect Studio Tutorial postcard. However, they display the same capabilities 
shown previously. Therefore, the following tasks are listed in brief.  

25. Use the Copy Fitting option to adjust long names in the 
“Welcome” text box. 

a. Add Copy Fitting to the first name appearing in the Welcome 
page (see Figure 53). 

b. Use the Go to Longest… command to preview your settings. 
For help, see task  12 on page 18. 

Figure 53: Copy fit the first name Content Object appearance 

 

26. Create a Style Content Object to change character style 
(color). 

In the current design, the text placed on the school background color scheme is 
blue. The blue text looks good only for the School of Medicine, for all the other 
schools and for a missing school record, change the text color to white, so that 
it can be easily read on darker backgrounds. 
The required Character Styles have been predefined in the InDesign document 
(see the Characters Style panel in Window menu > Styles > Character 
Styles). 

• White: to color the text white 
• Blue: to color the text blue 
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Create a Style Content Object, named Text Color Scheme, and tag the text on 
the dynamic backgrounds to it (The Schedule bottom of page 1 (front), and the 
three story boxes containing Event Details on page 2 (back)).  

To tag the text, select the Type tool ( ) and highlight all the text to be 
tagged. Next, double-click the Text Color Scheme Content Object. The rule 
would read as follows: 
If   school is Medicine  

Then  show style ‘Blue [C]’ 

Otherwise show style ‘White [C]’  

Make sure that the Rule matches Figure 54: 

Figure 54: Using Character Style in a Style Content Object 

 
Hint: using Character style in a Style Content Object is the same as using 
Object Styles in it. 
For help, see task  20 on page 44. 

27. Edit Address Block to become dynamic and the City & 
state to be written using UpperCase & TitleCase styles. 

a. Tag the “Address Line 1”, “Address Line 2”, “City”, “State” and 
“ZIP” address box elements with their corresponding Content 
Objects. 
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Note that Address line 2 does not always have values in it. Leave 
the empty content line as is. In a later stage, you will learn how to 
suppress trailing spaces on empty content (See task  30 on page 62) 
For help, see task  10 on page 16. 

b. Format State Content Object to capitals (using the common 
function “UPPERCASE”). 
Hint: You do not need to create new Content Objects, just format the 
existing ones. 
For help, see task  16 on page 29. 

c. Format City Content Object to Title case (using the common 
function “TitleCase”). 
Hint: You do not need to create new Content Objects, just format the 
existing ones. (The TitleCase function appears next to the 
UPPERCASE function in the Rule Editor.) 
For help, see task 16 on page 29. 

d. Test the design using the Record Selector. 
Check record # 5 and make sure it appears as shown in Figure 55. 

Figure 55: Address Box with Text Content Objects (and “UPPERCASE” 
formatting) for Recipient # 5 

 
Note that in some records, the second address line may be empty.  
You will fix this issue in task  30 on page 62. 

28. Modify the School Image Rule to handle an empty data 
for the school name in School Image. 

The condition you need to set is:  
If         trimmed [school] (name) is not empty -  

Then     show image named [school].  

Else    show image named ‘General’ . 

Make sure your rule matches Figure 56. Browse to Recipient 6 to check if the 
right school image is shown for Recipients with an empty school name. 
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For help, see task  18 on page 36. 

Figure 56: Empty School Name 

 
 

29. Show and hide the Chart and Chart title Layer to handle 
an empty data for the school name situation 

When no school appears in the data source, no chart should be drawn for 
the recipient. Therefore, the chart title should not appear and other text 
should replace it. To enable the show/hide visibility option, the chart, chart 
title and chart text replacement are placed on different layers named: Chart, 
Chart Title and Chart replacement. 

a. Create a New Content Object named “Chart Title”. 
Change the Content Object type to Visibility Content Object and set 
the following condition: 

Is Visible if trimmed [T]School is not(<>) empty 

 

b. Create a New Content Object named “Chart replacement”. 
Change the Content Object type to Visibility Content Object and set 
the following condition: 

Is Visible if trimmed [T] school is (=) empty  
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c. Tag Chart Title layer with the Chart Title Content Object by 
selecting the layer and double clicking the Content Object name.  

d. Also tag Chart Replacement Layer with Chart replacement 
Content Object. 

For help, see task  19 on page 40 

J. Adjust Content to Handle Blank Lines and Extra 
Spaces 

In some cases, empty or missing Content Object values may cause extra spaces 
and blank lines.  This section shows how to handle such cases.  

30. Suppressing Trailing Spaces on Empty Content 
This procedure addresses the problem you came across in task  27 on page 59: 
The Address2 Content Object had no value for some of the records, resulting in 
a blank line in the Address box, between the Recipient's Address1 line, and 
the City-State-ZIP line.  
The option to Suppress Trailing Spaces on Empty Content removes the 
empty space left by a Content Object and either the carriage return or space 
that follows it. This option is most often used for blank address lines. However, 
it can be used to help with wording in a paragraph or even to suppress extra 
spaces where a middle initial would be.  
Proceed as follows: 

a. Click to select the “Address” text box and right-click it, or Cmd-
click on a Mac. From the menu, select “Dynamic Story 
Properties” > “Suppress Trailing Spaces on Empty Content” 
(see Figure 57).  

Figure 57: Dynamic Story Length Menu 

 
This option removes the space from left by the empty Address2 value 
and the following carriage return. 
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Figure 58: Dynamic Story Length – Before and after (record 2) 

      

K. Print The Postcard 
Dynamic Documents can only be printed from the uCreate Print Panel Menu (not 
via InDesign Print options). For the purpose of this exercise, you will print the 
uDirect Studio Tutorial postcards in a PDF output format, for the first twenty 
Recipients in the Data Source.  

 Note: the free trial version of uDirect does not permit Dynamic Printing. If you 
need to evaluate the output from uDirect before purchasing, please contact your 
XMPie or Xerox sales representative and request a 30-day trial license. 
For a full list of the available Dynamic Print options, please refer to the uCreate 
Print User Guide by clicking Help on the uCreate Print Panel menu. 
Proceed as follows: 

a. Show the uCreate Print Panel menu by clicking the button at the 
top right corner of the uCreate Print Panel ( ), and select the 
“Dynamic Print” option (see Figure 59). 
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If you have unsaved changes, you are prompted to save the Design. 

Figure 59: uCreate Print panel – Dynamic Print 

 
The Dynamic Print dialog is displayed. 

Figure 60: uCreate Print panel Dialog 
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b. From the “Format” drop-down list, select “Adobe(r) PDF.” 
The Format setting defines the Variable Information (VI) output 
format in which the files are printed. uDirect Studio version 6.0 
provides all print output formats by default, including JPEG, Adobe 
PDF,  Adobe PostScript, Creo VPS, PPML/PS (v1.5 & v2.1), Xerox 
VIPP, and PPML/VDX. . 

c. In the “Records” text boxes, set the “To:” box to 20, to print 
only records 1-20 from the Data Source. 
By default, the range includes all records in the Data Source. You 
may also print a single record by entering its number in both From: 
and To: text boxes. 

d. Use the default “Destination” setting.  
uCreate Print automatically creates a folder named Output next to 
the InDesign document. 
The Output folder includes a sub-folder named using the current 
date and time, which contains all output files. To set a different 
destination, click Browse to open the Browse for Folder window 
and select to the desired folder. 

e. Click “OK” to close the window and begin printing your uDirect 
Studio Tutorial postcards. 
The Dynamic Print Progress window is displayed, allowing you to 
monitor the progress of the output files’ production. 

f. When printing completes, check the output files. 
In your Tutorial folder, open the Output folder and the sub-folder it 
contains, and review the personalized uDirect Studio Tutorial 
postcards. 
This is a two-sided postcard, so the output will be two pages per 
Recipient (one 40-page PDF). 

 
Congratulations!  
You have produced the uDirect Studio Tutorial VDP postcard, 
and have successfully completed the uDirect Studio Tutorial. 
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Quick Task List 
Below is the list of tasks that appear in this tutorial. This list is intended to serve as 
a checklist you can refer to as you follow the procedures and progress through the 
tutorial. 

A. GETTING STARTED ............................................................................................................................ 10 

1. DOWNLOAD THE TUTORIAL FILES. ........................................................................................................ 10 
2. UNZIP ”UDIRECT STUDIO TUTORIAL” INTO A NEW FOLDER. ..................................................................... 10 
3. LAUNCH ADOBE INDESIGN. .................................................................................................................. 10 
4. DISPLAY THE UCREATE PRINT MENU. .................................................................................................. 11 
5. OPEN THE “EDU_STATIC.INDD” INDESIGN FILE (FIGURE 4). .................................................................. 11 
6. ENABLE INDESIGN AUTOMATICALLY LOCATE LINKS. ............................................................................... 12 
7. (OPTIONAL STEP) CHANGE THE FONTS IF NEEDED . ............................................................................... 12 
8. SAVE THE DOCUMENT WITH THE NEW NAME. ......................................................................................... 13 
9. LINK THE POSTCARD TO A DATA SOURCE. ............................................................................................ 13 

B. DYNAMIC TEXT ................................................................................................................................... 16 

10. REPLACE THE STATIC RECIPIENT NAME (“MARY”) WITH DYNAMIC CONTENT CONTAINING THE RECIPIENT’S 
FIRST NAME. ....................................................................................................................................... 16 

11. PREVIEWING DYNAMIC CONTENT .......................................................................................................... 17 
12. LOCATE AND HANDLE LONG TEXT VALUES ............................................................................................. 18 
13. RENAME THE SCHOOL  CONTENT OBJECT ............................................................................................ 20 
14. REPLACE THE STATIC SCHOOL NAME “MEDICINE” WITH THE SCHOOL NAME CONTENT OBJECT. ............... 21 

C. DYNAMIC GRAPHICS ......................................................................................................................... 23 

15. REPLACE THE STATIC SCHOOL IMAGE WITH A DYNAMIC GRAPHIC. ........................................................... 23 
D. RULE EDITOR ...................................................................................................................................... 29 

16. CREATE UPPERCASE FIRST NAME CONTENT OBJECT TO BE USED IN THE RECIPIENT’S ADDRESS. ............ 29 
17. GIVE DIFFERENT DISCOUNT TO EACH SCHOOL USING FEE DISCOUNT CONTENT OBJECT ......................... 32 
18. ADJUST THE SCHOOL NAME TO FIT AN EMPTY DATA SITUATION. .............................................................. 36 

E. DYNAMICALLY SHOW AND HIDE LAYERS ..................................................................................... 40 

19. SHOW AND HIDE THE “SCHOLARSHIP” LAYER ACCORDING TO THE STUDENT’S GRADE AVERAGE. .............. 40 
F. DYNAMICALLY CHANGE STYLE ...................................................................................................... 44 

20. CREATE A STYLE CONTENT OBJECT TO CHANGE BACKGROUND COLOR (OBJECT STYLE) ........................ 44 
G. USE UIMAGE TO GENERATE DYNAMIC GRAPHICS. ..................................................................... 48 

21. CREATE UIMAGE GRAPHIC CONTENT OBJECT (CHALK BOARD). .............................................................. 48 
H. CREATE A CHART TO DISPLAY DYNAMIC DATA RELATED TO THE RECIPIENT. .................... 52 

22. CREATE A TABLE CONTENT OBJECT (COST SUMMARY) ........................................................................ 53 
23. CREATE A DYNAMIC UCHART CHART BY TAGGING A GRAPHIC FRAME WITH A TABLE CONTENT OBJECT .. 54 
24. DEFINE UCHART PROPERTIES ............................................................................................................. 54 

I. TUTORIAL REVISION- ADDRESS BLOCK AND SCHOOL IMAGE ................................................. 58 

25. USE THE COPY FITTING OPTION TO ADJUST LONG NAMES IN THE “WELCOME” TEXT BOX.......................... 58 
26. CREATE A STYLE CONTENT OBJECT TO CHANGE CHARACTER STYLE (COLOR). ....................................... 58 
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27. EDIT ADDRESS BLOCK TO BECOME DYNAMIC AND THE CITY & STATE TO BE WRITTEN USING UPPERCASE & 
TITLECASE STYLES. ............................................................................................................................ 59 

28. MODIFY THE SCHOOL IMAGE RULE TO HANDLE AN EMPTY DATA FOR THE SCHOOL NAME IN SCHOOL IMAGE.
 60 

29. SHOW AND HIDE THE CHART AND CHART TITLE LAYER TO HANDLE AN EMPTY DATA FOR THE SCHOOL NAME 
SITUATION........................................................................................................................................... 61 

J. ADJUST CONTENT TO HANDLE BLANK LINES AND EXTRA SPACES........................................ 62 

30. SUPPRESSING TRAILING SPACES ON EMPTY CONTENT ......................................................................... 62 
K. PRINT THE POSTCARD ...................................................................................................................... 63 

1. LAUNCHING THE RULE EDITOR ............................................................................................................. 73 
2. USING THE RULE EDITOR’S BUILDING BLOCKS ...................................................................................... 73 
3. CREATING VARIOUS TYPES OF RULES ................................................................................................... 75 
1. PASTE THE DATA COLUMN HEADER WITHIN <> BRACKETS IN THE PHOTOSHOP IMAGE FILE. ...................... 77 
2. SET THE TEXT LAYER NAME TO BE DIFFERENT FROM ITS TEXT CONTENT. ................................................ 77 
3. RECORD AN ACTION TO INCLUDE THE CHANGES YOU WISH TO MAKE TO THE DYNAMIC TEXT LAYER. .......... 77 
4. CREATE AN OPTIMIZATION PATH ........................................................................................................... 78 
5. EXPORT THE TEMPLATE AS A PACKAGE ................................................................................................. 79 
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Appendix A: Hardware and Software Requirements  
uCreate Print v7.1 can run either on Windows or Mac. 
The minimal system requirements are as follows: 

Windows  
• Processor: Intel® Core  2 Duo or better 

• Operating System:  

• Microsoft® Windows 7 Pro with Service Pack 1 or higher (works with Adobe 
CS6, CC or CC-2014 (10.x)) 

OR 

• Microsoft Windows 8 Pro or Windows 8.1 Pro (works with Adobe CS6, CC 
or CC-2014 (10.x)) 

Macintosh  
• Processor: MacIntel 2GHz or better. 

• Operating System:  

Mac OS X 10.7, 10.8 or 10.9 General Requirements (example) 
• 4 GB RAM or more 

• 250 GB Hard Disk (recommended 320 GB) 

• CD/DVD-ROM Drive 

• 10/100/1000 Mbps Ethernet Adapter 

• Adobe InDesign  CS6, CC or CC-2014 (10.x) 

• Adobe Photoshop and Illustrator CS6, CC or CC-2014 (10.x) 

• The uDirect Studio EDU Tutorial folder placed on your hard drive. 

• The tutorial materials are described in detail in the Quick Reference to 
Campaign Content Objects section on page 6. 
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Appendix B: uDirect Studio Tutorial Materials Specifications 
The following list defines all files required for a variable data Campaign (Data, 
Design, Assets, etc.), and describes the specific example files used in this tutorial. 

• Data- the Data Source file containing the Recipients’ personal details. 
EDU_prospectives.csv - 99 records, CSV file (20 records that repeat 
themselves). To examine this Data Source, open it with Microsoft Excel, 
Windows, Notepad or Mac OSX TextEdit. 
EDU_Scores.csv - 13 records, for a Chart use uChart. To examine this Data 
Source, open it with Microsoft Excel, Windows, Notepad or Mac OSX TextEdit. 

Note: This type of file is a flat database table that many Contact or Address Book 
programs can generate. 

• Design- The static InDesign document to be edited with uCreate Print. 
EDU_ static.indd - this is the InDesign document created by the designer for a 
specific Recipient, before adding variable rules to it. All objects appear as the 
Recipient should see them in the completed postcard. 
 

• Resources - Graphic files that remain fixed for all Recipients. 
The graphics in the “Resources” folder are: 
1. EDU_Mary.jpg- the girl writing on a Board image on page 1 (front).  
2. StudentsFront.jpg- the students image on page 1(front)  
3. StudentsBack.jpg- the students image on page 2 (back)  
4. XMPieLogo.eps- the XMPie logo on page 2 (back) 

 

• Assets - Graphic files that change per-Recipient. 
The graphics in the “Assets” folder are: 
1. Medicine.jpg- the School of Medicine Academic School image  
2. Engineering.jpg- the School of Engineering Academic School image  
3. General.jpg- the general Academic School Image- appears when there is 

no data in the Data Source about a requested school. 
4. Output Folder- A folder where the generated personalized images files, 

created by uImage, are saved. 
 

• In the  uDirect Studio EDU Tutorial folder you will also find the 
EDU_Completed.indd file.  

This is the above Static Document, after it has been transformed into a 
Dynamic Document using uDirect Studio. It is provided so you can appreciate 
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the end result of the tutorial. Note: The required document size is 5.6’’ x 4.25’’ 
with a built-in 0.125’’ (9pt) bleed (Approximately 142x108mm with 3mm bleed.) 
 

uImage Template- a folder containing files used for the uImage template: 
1. EDU.psd- the Marketplace SimpleMath Photoshop file 
2. EDUTutorial.atn- The action used for the EDU.psd 
 

The uDirect Studio Tutorial Campaign materials (described above) are available in 
the uDirect Studio Tutorial folder (along with this PDF). 

Figure 61: The XMPie Tutorial Folder. 
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Appendix C: Learn to Use the uCreate Print Panel 

As explained in the Appendix B: uDirect Studio Tutorial Materials Specifications on 
page 69, the Data Source your Design is now linked to is a database table.  
The table’s columns contain different types of Recipient data: ID, First Name, Last- 
Name, School, etc.  
The table’s column headers are known as fields and each row contains the data 
for a record, the first three records are shown in Figure 62. 

Figure 62: Data Source Sample—EDU_Prospectives.csv (First Three Records) 

 
Once you link to a Data Source table, uCreate Print automatically creates an 
object for each of the table’s column headers. These objects are known as Content 
Objects. 
When you edit your design with uCreate Print, you use simple point-and-click 
operations to tag different design objects, such as a text frame or graphic frame, 
with the desired type of Content Object; for example the First Name Text Content 
Object or the School Image Graphic Content Object. Such a tagged design object 
becomes a Dynamic Object: a design object that derives its content and/or 
appearance from the Content Object’s value. 
The uCreate Print panel lists the Content Objects created for the column headers 
of the linked Data Source (Figure 63): 

Figure 63: uCreate Print Panel with Content Objects 

 
 

View Content Object Type 

Highlight Dynamic Objects 

Proofing Options (Content Sources) 
Browse to Content Source Resize Palette 

Content Object list 

Content Object data for 
current recipient 

Record Selector (e.g. 1 of 100) 

Dynamic Visibility of the active 
layer & spread 

Opens the Palette Menu 

Current Content Source (e.g. the name of the linked Data Source) 

Show Content Objects or 
Variables 
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The populated uCreate Print Panel shows the following details and options: 

• Content Object Type—Use the View drop-down list to show All Types of 
Content Objects, or to filter the list to show a specific type (e.g., Text, 
Graphic, Visibility etc.). 

• Show Content Objects or Variables—While Content Objects are 
available to place into the document design, Variables are used behind the 
scenes. Variables use the same kind of business rules or logic that we 
used for Content Objects in this tutorial. Variables are useful to calculate a 
value once – you can then use that variable in several Content Objects 
instead of having to calculate the value each time. 

• Content Object list—lists the names and types of the Content Objects 
included in the Data Source you are currently linked to. 

• Highlight Dynamic Objects—when InDesign’s Screen Mode is Normal, 
this check box provides a visual indication of the Dynamic Objects included 
in your Document, by highlighting them in the Document window and 
displaying the names of the Content Objects they are tagged with. 

• Proofing Options—uCreate Print offers you a number of ways to check 
what your Dynamic Document will look like when actual values are used in 
place of the Dynamic Objects. These actual values can come from various 
types of content sources, including your Data Source, a Proof Set file or 
Content Samples. 

• Dynamic Visibility— Opens the Dynamic Visibility dialog, so you can 
assign a Visibility Content Object to the active spread ( ) or active layer 
(  Note that the icon is the color of the active layer). When Dynamic 
Visibility is assigned, an eye symbol is added to the respective icon (e.g.

). 

• Record Selector (  )- used to proof your Dynamic Document: 
browse through the records of your content source (the linked Proof Set, a 
Content Sample or the linked Data Source), and see how the Dynamic 
Objects’ content changes when you scroll from Recipient to Recipient. 

• Resize Panel—to see the complete list of Content Objects, resize the 
panel by dragging its bottom right corner. Alternatively, use the horizontal 
scroll bar to scroll down the list. 

The complete list of Content Objects used in this tutorial is shown in Figure 63. 
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Appendix D: Learn to use the Rule Editor 
In the tutorial, you defined Content Objects based on two attributes: their Name 
and their Type.  
In addition, Content Objects are defined by their Business Rule (Rule, in short): an 
expression that is part of the Campaign Logic, and determines how to calculate the 
Content Object’s value for each Recipient. 
When you connect your Design to a Data Source, uCreate Print automatically 
creates a Content Object for each column header in that Data Source. You may 
wish to edit these Content Objects or create new ones, to tag your Design with 
dynamic formatting, conditional Rules or arithmetic operations. 
Content Objects are both edited and created using a Rule Editor. 
The Rule Editor is a simple graphic user interface, consisting of basic drop-down 
lists and text boxes. It is specifically designed to allow non-technical users to easily 
define or modify Content Object Rules. 
In the Task List - Rule Editor part, you edit the Rules of some of our Content 
Objects, to reflect EDU University’s Business Rules for Variability in the Design 
(page X).  
Here are some of the “Rule Editing basics” you should be aware of: 

1. Launching the Rule Editor 
You can launch the Rule Editor in one of the following ways: 
• To add a new Content Object— in the Content Object list, right-click, or 

Cmd-click on a Mac, anywhere, and select New Content Object… from the 
menu. The Rule Editor’s New Content Object window is displayed (see 
task  17 on page 32). 
 

• To edit an existing Content Object— in the Content Object list, right-click, 
or Cmd-click on a Mac, select the Content Object you wish to edit and then 
select Edit Rule… from the menu (see task  18 on page 36).  

The following description applies to both the New Content Object and the Edit 
Content Object windows of the Rule Editor. 

2. Using the Rule Editor’s Building Blocks 
Figure 64 below shows an example Rule Editor window, used to edit a Text 
Content Object (First Name). The drop-down lists have been collapsed to reveal 
the available options. 
The Rule Editor options vary, depending on the type of Content Object you are 
currently editing or defining (Text, Graphic etc.). 
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Figure 64: Rule Editor—Edit Content Object "First Name" 

 
 
 
 
 
 
The top section of the Rule Editor defines Content Object properties such as its 
Name (for example, First Name) and Type (for example, Text).  
The bottom section defines the Content Object’s Rule, in the form of an 
expression. 
• The first drop-down list determines whether this Rule sets a value or a 

condition. 
• The second drop-down list contains building blocks for defining the Content 

Object’s value or condition: literal values (string or number), functions 
(common and extended), and an alphabetical list of the Data Source 
columns. 

• The third drop-down list includes operations, such as “+”, “-”etc. When you 
define a condition (by setting the first drop-down list to “If”), the operations 
list is enhanced with comparison operators, such as “AND”, “OR” etc. 

Rule Type: 
Value / Condition 
 

Rule  
Building 
Blocks  

Rule Building 
Blocks: 
• Literal Values 
• Common Functions 
• Extended Functions* 
• Data Source Fields 
 

Operator
 

Content Object Type 
 

* Check to show 
Extended 
Functions 
In the Rule 
Building Blocks 
list (the second 
drop-down list) 
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3. Creating various types of rules 
a. Value Rules 
To define a Rule as a value, set the first drop-down list to “Value= “ for 
Text Content Objects, “Graphic=” for Graphic Content Objects etc. 
Value expressions are used in the following cases: 

i. The Content Object is a Data Source Column Header: 
A Content Object created for a Data Source Column Header is 
fed with the value of the appropriate Data Source field, and this 
value changes dynamically per-Recipient. For example, the 
First Name Content Object receives the value of each 
Recipient’s First Name field (for example, Jane). 
(See task  10 on page 16) 
You can use Value Rules to recreate Content Objects that 
were deleted from the Design. 

ii. The Content Object has a literal value (a number or a string 
of text): 
You can set a Content Object to use a fixed value, which will 
be common to all Recipients. For example, to set the value of 
a school of Medicine image Graphic Content Object, specify 
the image’s filename, for example, “Medicine”.  
(See task  14 on page 21). 

b. Conditional Rules 
Conditional rules allow you to determine a Content Object’s value using 
“If-Then-Else” statements. In this case, you will use a Conditional rule to 
determine the value of the Discount Content Object, depending on the 
value of the School Data Source field:  
If the value of School is Engineering then the value of the Discount is 
20%. Otherwise (Else), the value of the Discount is 15%. 
(See task  17 on page 32). 
c. Functions 
Functions are displayed in the second drop-down list. Functions give you 
tasks convert and manipulate incoming data values so that it fits your 
specific needs. 
By default, the drop-down list shows only common functions, used to 
format Content Objects: TitleCase, lowercase, UPPERCASE or Length. 
To display more advanced functions (such as “FindAndReplace”, 
“FormatDate” etc.), check the Extended Functions checkbox. 
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For a detailed description of all uCreate Print functions, refer to the 
uDirect User Guide. (See task  18 on page 36). 
Note that a Rule may consist of one or more “Value Rule” and 
“Conditional rule” lines. To add more Rule lines, use the AND/OR 
options of the operations drop-down list. 
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Appendix E: Prepare a Photoshop file to work with uImage, 
and pack it as a uImage package 

Adding dynamic content to an image is done using a uImage file in InDesign.  
The dynamic content is taken from the Data Source used in uCreate Print for the 
document that contains the image. 
When working on the image in Photoshop, the data (the name of the column 
header in the Data Source) should appear in the image itself. 
After you finish designing the Photoshop file- you need to export it as a package to 
be used in InDesign. 
Adding the data to the image in Photoshop is done as follows: 

1. Paste the data column header within <> brackets in the 
Photoshop image file. 
Create a new text layer for the dynamic content. 
The relevant Data column header (for example FirstName) should appear in 
the text layer within <> brackets (for example, <FirstName>). 
These brackets are used to define copy fitting to the text: overflow, underflow or 
both. 
To enlarge the text placeholder (for example, for longer names in the Data 
Source), add as many dots as you wish, before the Data column header 
(for example: <…..FirstName>). 

2. Set the text layer name to be different from its text 
content. 
When the image is used in InDesign uImage, an image is created for every 
record in the Data Source and includes its dynamic content. If the layer’s name 
is the text it includes, the name of the layer changes in every image production 
and recorded actions (see task 3 below) may not be able to be performed on 
that layer. 

3. Record an action to include the changes you wish to make 
to the dynamic text layer. 
In Photoshop, you may want to change the text display using Photoshop tools. 
These changes should be recorded using the Action Panel, in order to be 
performed in the same manner on each record, when attached to dynamic 
data in InDesign. 
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Note that the action name and the folder name that contains the action are 
used when creating the uImage package. (See Figure 67). 

4. Create an optimization path 
Adding an "optimization path" improves the performance of uImage 
personalized images. An optimization path is a rectangular path added to the 
uImage template that surrounds the expected variable area.  
Note that the area is not where the variable text was initially, but rather where 
the text is after the action is performed as shown in Figure 65: 

Figure 65: Optimization Path 

  
a. Use the "Rectangular Marquee Tool" and create a selection 

rectangle encompassing the potential variable area. 
b. Right click the image, select "Make Work Path” and click OK in 

the dialog box that opens.  
This converts the selection into a work path. 

c. In the “Paths” panel, select “Save Path” from the menu and 
save the work path (which should be currently selected). Name 
the new path. In the example shown in Figure 64, the name used 
was “uImageOptimization”. 
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5. Export the template as a package 
After you finish designing the document template, you should export it as a 
package (*.dpkg).This process is done as follows: 

a.  In Photoshop, under the “File” menu, select the “Automate” 
function and open the sub menu. In the submenu select “Export 
XMPie DPKG”. The Export window is displayed (See Figure 66). 

Figure 66: Export a uImage package 

 
b. In the opened dialog box, select the location where you want to 

save the uImage package. In the EDU sample, you used the 
uImageTemplate folder. Click Save. The “Export XMPie uImage 
Document Package” settings dialog is displayed (See Figure 67). 
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Figure 67: The “Export uImage Package Document Template” Settings dialog 

   
c. Select the “Template Type” from the drop-down options: 

Regular – for generic uImage template. 
Image Font- for Image font used in the uImage template 
Separated Letters - for separated letters used in the uImage template 

d. Select the desired copy fitting mode and method. 
As you can see, the action used in the Photoshop file is already set in 
the Pack Action or Script section. You may change it to something 
else if necessary. 
You can also see that the uImage Tags, which are the Data field used 
in the template, are mentioned in the Additional information, together 
with the fonts used. 

e. Select an optimization path 
Including an optimization path with a Photoshop template can 
significantly improve the performance of image generation. 
In our example, the template contains a rectangular path named 
"uImageOptimization" that can be used for the optimization. In the 
export dialog check "Include Optimization Information" and select the 
optimization path - "uImageOptimization". 
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f. Click Export. The export process may take a few seconds. 
g. The document is ready for use in InDesign. 

You can open a Photoshop document package in Photoshop by clicking 
Automate (under the File menu) > Import XMPie DPKG. 
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Appendix F: XMPie Terminology 
The following is a glossary of XMPie terminology relevant to this tutorial.  
For the complete uCreate Print glossary, refer to the uCreate Print User Guide. 
Asset Source—in the XMPie context, this term refers to a collection of Campaign 
Assets (e.g., images, formatted text files, etc.) and its location. You can define one 
or more Asset Sources for a single Campaign. 
Assets—in the XMPie context, this term refers to content (such as graphic files 
and text files) that feeds the Dynamic Objects in a Design (as opposed to 
Resources, which are static content)... 
Business rule—see Rule. 
Campaign— a representation of a set of Dynamic Documents, possibly of different 
types, all sharing the same Plan file, Data Source(s) and Asset Source(s). 
Content Object (also known as ADOR Object)—an object of the Plan that is 
visible to a Design (via the "Link to Plan" operation of uCreate Print). When linking 
directly to a Data Source, the Plan is not explicit; it is "behind the scenes" and is 
automatically created and maintained to reflect linking to Data Sources, adding 
Content Objects or specifying Rules. Hence, in uCreate Print Content Objects are 
visible only through the uCreate Print Panel. 
Content Objects can be of various design-centric types, e.g., text, graphic, etc. The 
designer uses simple point-and-click operations to tag a design object (say, a text 
frame or graphic frame) with the desired Content Object. Such a tagged design 
object becomes a Dynamic Object: a design object that derives its content and/or 
appearance from the Content Object’s value. Content Object values are calculated 
by the Plan’s Rules, using the given Data Source(s).  These calculations are 
performed iteratively, once for each Recipient, resulting in a set of Recipient-
specific values for each Content Object. In a way, one can think of Content Objects 
as the intermediaries between the Logic (i.e., Plan) and Data (i.e., Data Source) 
and the Design (i.e., XMPie tagged document). 
Content Samples—a set of possible values, defined by the user, for a given 
Content Object; different Content Objects can have different sets of values 
associated with them. There are no constraints on these values; except that they 
need to adhere to the type of Content Object with which they are associated (e.g., 
the Content Samples associated with a Graphic Content Object should be a set of 
images). For example, one can define three images— "CarA", "CarB", and 
"CarC"—as the possible values of a "CarPicture" Graphic Content Object. It is then 
possible to flip through these Content Samples, to see how the different images 
appear in the Design, without being forced to rely on a complete Plan or on Proof 
Sets that may not necessarily be available at the early stages of the design 
process. 
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Content source— the source that provides values that feed the Content Objects 
(via Rules or directly), which in turn change the content (or format) of the Dynamic 
Objects in your design. There are different types of content sources, including Data 
Sources, Proof Sets and Content Samples. 
Copy Fit—adjustment of the type size to make text fit in a given amount of space. 
Data— one of the Dynamic Document’s basic components. In the XMPie context, 
the Data component is represented by Data Sources and Asset Sources. 
Data Schema— a description of the Data Source structure that is expected by the 
Logic. The Data Schema specifies the following: the required tables; each table’s 
column headers (e.g., "First Name", "Customer ID", etc.) and the type of data they 
represent (e.g., a string, an integer etc.); and the relationship between these tables 
(e.g., a common field).   
Data Source— represents the Dynamic Document’s Data component, which is 
common to all Dynamic Documents in a given Campaign. The schema of the Data 
Source must adhere to the Data Schema defined by the Campaign's Plan file. 
Each Campaign may have multiple Data Sources, in any ODBC compliant format 
(including Oracle, MS-SQL, MySQL, IBM-DB2, CVS, XML and MS Access). 
Design (also known as Tagged Documents, Dynamic Document Templates and 
uProduce Documents)—a document (such as an Adobe InDesign document) that 
includes regular and tagged design objects. Tagging is performed using the 
uCreate Print plug-in of the relevant host application (Adobe InDesign, Adobe 
GoLive, and Adobe Dreamweaver are currently supported). 
Document instance— a copy of the Design that was instantiated for a given 
Recipient. A production run of a given Dynamic Document for a batch of, say, 1000 
Recipients results in 1000 Document instances. 
Dynamic Document—a modular binding of three components: Logic, Data and 
Design. Practically speaking, these components are represented by a Plan file, a 
Data Source and a Design (respectively). When linking directly to a Data Source, 
the Plan file is not an object that is visible to the user; however, it is created as the 
user works with Data Sources and Rules, and is represented internally, as part of 
the Dynamic Document. 
Dynamic Document Template (also known as a Tagged Document)—see Design. 
Dynamic Object— a design object (e.g., a text frame or a graphic frame) that is 
tagged by a Content Object. This tagging transforms the design object from static 
to dynamic. A Dynamic Object derives its content and/or appearance from the 
Content Object’s Recipient-specific value (as opposed to showing a pre-set, static 
value). 
Dynamic Publishing— a discipline of Publishing that aims to produce any 
customizable document, in any media, on-demand. Dynamic Publishing extends 
Variable Data Printing (VDP) into digital print and electronic media, focusing not 
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only on final output media but also on creating documents with dynamic content, 
from Design to Production. 
Expression—the Rule that drives the information for a Content Object. Use the rule 
editor to modify the expression for a given Content Object. 
Graphic (Content Object)—the textual name of a graphic asset file. Graphic files 
can be .jpg, .gif, .eps, .tif, and so on depending on the desired output. 
Logic— the set of Content Objects; the QLingo expressions that compute their 
values for a given Recipient; and the interface to Data. When linking directly to a 
Data Source, the terms "Logic" and "Rules" are interchangeable. 
PersonalEffect—the high-level version of XMPie’s revolutionary solution for cross-
media direct marketing. Makes personalized publishing across multiple channels 
simple and cost-effective. Personal Effect consists of three modules: a web-based 
production server, uProduce, and two desktop tools, uPlan and uCreate, for 
campaign creation. 
Plan—the encoding of Logic in the Campaign; it is encoded in XML, and stored in 
files with a ".plan" extension. When linking directly to a Data Source, the Plan is 
encoded internally, as part of the document, thus it is not visible as a separate 
object.  
Print file (also known as Print Stream)—an output file in one of the print or 
Variable Information (VI, in short) data printing formats (PDF, VPS, PPML, VIPP, 
PPML/VDX or PostScript), which is further processed by a print controller (i.e., 
RIP). The processing of a print file by a print controller produces a series of hard-
copy printed Document Instances, each representing the variations made for a 
specific individual.  
Proof Set—an XML-encoded table where columns represent Content Objects and 
rows represent a set of values—one for each Content Object—for a given 
Recipient.  Proof Sets are generated by uPlan or uProduce. They are typically 
generated for a subset of the Recipients list, with possibly a few more filtering 
criteria, by executing the Plan for each such selected Recipient and storing the 
resulting Content Object values in that Recipient’s row. Sometimes Proof Sets may 
represent the whole set for which a specific production run is going to be executed. 
In such cases they may be referred to as Production Sets. 
QLingo—a scripting language developed by XMPie, to allow the use of classical 
conditional logic—such as 'if-then-else' or 'switch' constructs—in expressions that 
compute values for Content Objects or Variables in a Plan file. QLingo also 
supports many domain-specific constructs for formatting, process control, and 
other data manipulation functions. Together with SQL and the ability to call upon 
external functions, QLingo makes the Plan file expressions (e.g., Rules) extremely 
powerful, yet not overly complex.   
Recipient—the person who receives an individual instance of the Dynamic 
Document. If the Document is static, all Recipients receive identical copies; if the 
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Document is dynamic, each Recipient receives a unique Document instance, 
which has been personalized based on this Recipient’s specific data. 
Recipient List—a table whose records represent the Recipients of a particular 
Dynamic Document. At production time, a personalized Dynamic Document 
instance is generated for each Recipient (i.e., record) in this Recipient List. 
Resources— static graphic files, which are used in the design and are fixed 
throughout production (as opposed to Assets, which change per-Recipient). An 
example may be the company logo. 
Rule (also known as business rule)—part of the Logic defined in the Campaign’s 
Plan file.  Rules are expressions that calculate Content Objects’ values for each 
Recipient. Rules can also be added or edited using uDirect’s Rule Editor. When 
linking directly to a Data Source, the terms "Logic" and "Rules" are 
interchangeable. 
Static Document—a regular desktop publishing document, such as an InDesign 
document. 
Tagged Document—see Design. 
Text (Content Object)—Characters which can be letters, numbers and symbols. 
Note:  This is the default Content Object type, in other words all Content Objects, 
when first created are Text. 
Text file (Content Object)—the textual name of an asset file containing text 
formatted in a specific style: a preformatted tagged-text file for use with InDesign 
templates 
Variable—an internal object of the Plan, which can be assigned values of 
expressions (QLingo, SQL, etc.).  
Visibility (Content Object) —A Content Object that has true/false value which acts 
an ON / OFF switch to show or hide a layer or page spread. 
X-DOT—an acronym that stands for XMPie Dynamic Object Transparency (X-
DOT).  
X-DOT accurately reproduces, by using opaque objects, the visual effect of 
transparency in print output file formats that do not support live transparency. It 
creates one 'mega object' out of several 'atomic objects' that need to be combined 
to preserve the transparency effects between them. Transparency may be created 
when special effects (such as shadow, feathering or opacity) are used, or in an 
image file that contains transparency. 
XLIM—an acronym that stands for XMPie "Less is More". This composition 
technology from XMPie increases significantly the speed of generating print output 
streams for graphically simple (print) Designs. Such Designs are exported by 
uCreate Print as ".xlim" files and can be uploaded as such to a uProduce 
Campaign. uProduce includes the algorithms that process XLIM Dynamic 
Documents for generating print streams in an extremely speedy and efficient way. 
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Appendix G: Database Terminology 
A Flat database is one table, often stored in a text file, a Comma-Separated 
Values (CSV) file, or Microsoft Excel worksheet. 

 
CSV files are a special type of text file (Figure 68): 

Figure 68: Example CSV File 

 
• The first line is usually called a “header” or “header row”, because it 

contains the names of the fields. 

• Each line in this text file is a record. 

• Each record consists of one or more fields, which are separated by 
commas. Sometimes the text between the commas is placed inside quotes, 
to identify that the information is to be treated as if it were one piece of 
information. This is especially useful for hidden characters, such as 
carriage returns. 

 
Text files resemble CSV files (Figure 69): 

Figure 69: Example Text File 

 
• The first line is usually called a “header” or “header row” because it 

contains the names of the fields. 

• Each line in this text file is a record. 

• Each record consists of one or more fields which are separated by tabs or 
other kind of special character (for example: a pipe “|” symbol) 
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• Text/String fields are often placed inside quotes if there are spaces 
between the text. 

 
Microsoft Excel worksheets: 

Figure 70: Example Excel Sheet 

 
• The first line is usually called a “header” or “header row”, because it 

contains the names of the fields. 

• Each row is a record. 

• Each column is a field. 

• The first column is usually the key field.  
While it is not required, it is HIGHLY recommended that you always include 
a key field in your Excel sheets, even if you have to add it manually.  
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